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Sinopsis singkat: 
 

Tema paling sensasional yang berhasil dicetak dunia internet setelah e-commerce adalah web blog. Web 
blog adalah buku harian online yang boleh dibaca oleh siapa pun, termasuk Anda. Di negeri sendiri, website 
buku harian online ini berhasil merebut simpati puluhan bahkan ratusan peselancar online. Lantas, bagaimana 

sih membuat web blog itu? 

Lewat buku ini, penulis mengajak Anda menelusuri tahap-tahap pembuatan web blog mulai dari awal sampai 
akhir menggunakan Dreamweaver MX 2004 dan ASP. Seperti gayanya yang masih terus dipertahankan, isi 
buku ini didesain sangat santai tanpa perlu mengerutkan dahi meskipun Anda sedang membahas salah satu 

teknologi paling canggih saat ini.  
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Edisi Khusus Dreamweaver MX 2004
dan Active Server Pages

Membuat
Web Blog

Kalau ada teknologi website yang sanggup menciptakan kehebohan dan trend,
itu pastilah web blog. Awal bulan Juni 2004 lalu diselenggarakan kopi darat para
blogger yang kali ini mengambil tempat di lereng Gunung Merapi Yogyakarta,
atau lebih tepatnya di Kaliurang. Acara ini diramaikan oleh kira-kira 100 lebih
blogger dari seantero pulau Jawa. Bahkan kabarnya, peserta yang berasal dari
Bandung Jawa Barat berani menumpang Pesawat Hercules hanya untuk mera-

maikan acara para pecandu “online diary” ini.
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Pendahuluan

Mencari Definisi

Definisi
Web Blog

Kurang jelas siapa yang pertama kali menemukan teknologi ini. Yang pasti, ditilik dari
teknik pembuatannya, web blog tidaklah berbeda jauh dibanding Guest Book atau Elec-
tronic News biasa. Tentu, di dalam buku ini Anda akan belajar banyak bagaimana mem-
buat Web Blog menggunakan Dreamweaver MX 2004 dan Active Server Pages.

Lantas, apa itu sebenarnya web blog? Defi-
nisi web blog sangat mudah dicari di inter-
net. Namun, dari segudang referensi yang
ada, semuanya pada mengacu ke satu isti-
lah yang sama, yaitu web blog adalah
online journal atau online diary (buku ha-
rian online) yang dipublikasikan lewat in-
ternet dan boleh dibaca oleh siapa saja.
Coba Anda lihat definisi web blog yang di-
angkat dari kedua situs berikut ini:

 “On a Web site, a blog, a short form for
weblog, is a personal journal that is fre-
quently updated and intended for general
public consumption.”
—situs Whatis.Com

 “Short for Web log, a blog is a Web page
that serves as a publicly accessible personal
journal for an individual. Typically updated
daily, blogs often reflect the personality of
the author.”
—situs WebOpedia.Com

Yang jelas, web blog punya beberapa
ciri khas yang unik. Pertama, isi web blog
di-update (diperbarui) setiap saat oleh si
pemiliknya. Isi web blog bermacam-ma-
cam, mungkin berisi pengalaman kese-
harian si pemilik, unek-unek, cerita, atau
keadaan jiwa si pemilik yang dicurahkan

kepada khayalak umum dan menjadi kon-
sumsi banyak orang. Dilihat dari sifatnya,
web blog ini sangat mirip dengan buku ha-
rian pribadi. Hanya saja, kalau kita mau
main perbandingan, buku harian pribadi
online ini jelas beda jauh dengan buku ha-
rian pribadi biasa yang sering dimiliki
gadis-gadis SMP atau anak kecil.

Dulu, kita sering melihat buku harian
pribadi yang dilengkapi gembok logam.
Kalau tidak bergembok, pasti buku terse-
but disimpan di tempat yang paling rahasia
yang hanya si pemiliknya saja yang tahu.
Tapi, web blog berbeda 180 derajat. Justru
“buku harian online” ini terbuka bagi
siapapun—tanpa kecuali! Tak ada user-
name password atau hidden link di dalam-
nya, semua bisa membaca.

Lantas, bagaimana caranya membuat
web blog itu? Bagi orang awam, membuat
web blog merupakan angan-angan jika
mereka harus bersentuhan dengan bahasa
pemrograman berbasis internet seperti
PHP atau ASP. Untuk itu, mereka butuh
layanan pembuatan web blog instan yang
gratis. Di internet, ada segudang alamat
website yang disediakan bagi mereka yang
ingin memiliki web blog pribadi namun ti-
dak tahu bagaimana melakukan scripting.
Beberapa di antaranya adalah Blogger.
Com, Xanga.Com, LiveJournal.Com, dan
masih banyak lagi.

Aturan mainnya, mereka tinggal regis-
ter (mendaftar) dan mereka akan menda-
pat web blog pribadi secara gratis.
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Blogger.Com:Blogger.Com:Blogger.Com:Blogger.Com:Blogger.Com:     Bagi para pengguna awam atau
orang yang tidak terbiasa dengan web scripting,
Blogger.Com merupakan pilihan yang menarik.

Xanga.Com:     Selain Blogger.Com, pilihan lain
yang tak kalah menarik adalah Xanga.Com yang
memiliki lebih banyak layanan.

Mengumpulkan Teknologi

Teknologi Apa Saja
yang Anda Butuhkan?

Untuk membuat web blog sendiri, Anda

butuh beberapa teknologi. Semua teknolo-

gi ini mudah dicari dan ada di sekitar Anda.

Apa saja teknologi itu? Lihat point-point

berikut ini:

� Macromedia Dreamweaver MX 2004:

Software ini berfungsi untuk mendesain

tampilan web blog ini nantinya. Versi

yang kita pakai untuk membuat web

blog adalah versi MX 2004 yang dirilis

kira-kira akhir 2003 lalu.

� MS Access: Aplikasi web blog membu-

tuhkan database. Di dalam database ini-

lah semua arsip web blog disimpan dan

sewaktu-waktu dapat dimunculkan

kembali. Anda bebas menggunakan ver-

si berapapun untuk software MS Access

ini.

� MS Windows 9x/2000/2003: Untuk

scripting, kita memilih Active Server

Pages. Dan, teknologi ASP ini baru bisa

bekerja dengan maksimal pada sistem

operasi MS Windows yang sudah dileng-

kapi server, entah PWS atau IIS. Jadi,

pastikan sistem operasi Anda memiliki

salah satu jenis server di atas.

� Browser: Software ini berfungsi untuk

menguji script secara live dalam kompu-

ter Anda. Anda bisa menggunakan

browser Internet Explorer, Netscape

Navigator, atau Neoplanet sekalipun. Ti-

dak menjadi masalah tentang versi

browser yang dipakai sebab script ini be-

kerja secara server side.

Tentu, kurang seru rasanya kalau Anda

memanfaatkan fasilitas gratisan seperti di

atas. Bagi Anda yang tahu sedikit-sedikit

tentang web programming, Anda bisa

membuat web blog sendiri. Dalam buku

Special Project ini, Anda akan belajar ba-

gaimana memadukan software Dream-

weaver MX 2004, database MS Access, dan

teknologi Active Server Pages untuk mem-

buat web blog yang tak kalah serunya de-

ngan web blog lain yang digarap oleh ka-

langan profesional.
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Langkah 1:

Membuat
Database

Pertama-tama, kita harus membuat data-
base terlebih dulu tempat arsip-arsip web
blog diletakkan. Aplikasi yang kita butuh-
kan hanyalah MS Access yang sebagian besar
dari Anda memilikinya.

Langkah pertama adalah meluncurkan
aplikasi MS Access yang ada di komputer
Anda sampai Anda menjumpai tampilan
seperti berikut ini:

First Step:
Tampilan
seperti
gambar di
samping ini
akan dijumpai
segera
setelah Anda
meluncurkan
MS Access.

Kemudian pilihlah Option Blank Ac-
cess Database. Setelah itu tekan tombol
OK. Sebelum Anda mendesain tabel data-
base, Anda harus menciptakan file data-
base terlebih dulu. Simpan dengan nama
Blog. mdb dan simpanlah di folder
C:\InetPub\wwwroot\Webblog. Jika folder
ini belum ada, buatlah terlebih dahulu.

Blog.mdb: Sebelum mendesain tabel database,
Anda harus membuat filenya terlebih dulu. Buat
dengan nama blog.mdb dan simpan di folder
C:\InetPub\wwwroot\Webblog.

Selanjutnya, pilih Create Table in De-
sign View jika Anda sudah masuk ke tam-
pilan seperti gambar berikut ini:

Create Table in Design View:     Supaya Anda tidak
kesulitan saat mendesain tabel database, pilihlah
option ‘Create Table in Design View’.

Sekarang, Anda tinggal mendesain ta-
bel database seperti contoh tabel berikut
ini:

Nomor
AutoNumber
BlogID Text
Tanggal Date/Time
Waktu Date/Time
Nama Text
Judul Text
Blog Memo

           F F F F Field                                 Data ield                                 Data ield                                 Data ield                                 Data ield                                 Data TTTTTypeypeypeypeype

Jika Anda sudah mendesain tabel se-
perti di atas, pilihlah field Nomor dan jadi-
kan ia Primary Key.

Kemudian, tekan tombol File > Save.
Sejenak akan muncul jendela di mana
Anda harus memberi nama pada tabel ter-
sebut. Beri nama ‘Webblog’.
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Save As:Save As:Save As:Save As:Save As:     Berilah nama untuk tabel ini dengan
nama ‘Webblog’.

Langkah 2:

Membuat Aplikasi Pertama,
CreateBlog.asp

Karena baru pertama kali dibuat, database
web blog yang tadi telah kita ciptakan ma-
sih dalam kondisi kosong. Untuk itu, kita
harus mengisinya dengan record-record
agar website ber-blog ini memiliki content
seperti yang kita harapkan. Bagaimana
mengisi record ke dalam database itu? Kita
bisa melakukannya lewat script Active
Server Pages.

Pertama kali, kita akan buat script
yang nanti kita beri nama CreateBlog.asp.
Aplikasi ini akan menghasilkan form tem-
pat para pengunjung (blogger) mencurah-
kan isi hatinya.

Mari kita ciptakan script CreateBlog.
asp lewat bahasan-bahasan berikut ini.
Langkah pertama adalah membuat head-
line untuk memberi tahu pengunjung bah-
wa form ini berfungsi untuk membuat blog
baru. Tekniknya cukup sederhana, yaitu de-
ngan menggunakan potongan berikut ini:

<html>
<body>
<h3>Creating New Web Blog
</h3>

Tentu Anda bisa mengubah headline di
atas sesuka hati Anda. Kemudian, kita cip-
takan form. Mengapa? Karena tanpa
form, pengunjung tidak bisa mengisi
nama, isi hati, serta data-data lainnya.
Langkah pertama untuk membuat form
adalah dengan pernyataan berikut:

<form action=”insertblog.asp”
method=”post”>

Itu artinya, begitu tombol Submit di-
tekan, data-data yang ditulis oleh para pe-
ngunjung akan terkirim ke script
insertblog.asp yang nanti akan kita buat
belakangan.

Setelah itu, kita buat sekali lagi sema-
cam headline dengan ukuran lebih kecil.
Fungsinya untuk menegaskan agar pe-
ngunjung memasukkan data-datanya pada
form yang telah tersedia. Caranya yaitu de-
ngan menulis potongan berikut:

<h4>Tulislah curahan hatimu pada Form
berikut ini:
</h4>

Kalau sudah begini, kita tinggal mema-
sukkan semua komponen yang diperlukan
ke dalam halaman web. Inilah script leng-
kapnya untuk memasukkan komponen-
komponen itu.

Tanggal:
<input type=”text” name=”tanggal”
value=”<%=Date%>”>
<br>
Pukul:
<input type=”text” name=”pukul”
value=”<%=Time%>”>
<br>
Namamu:
<input type=”text” name=”nama”>
<br>
Judul:
<input type=”text” size=25
name=”judul”>
<br>
Isi Hatimu (Blog):
<textarea name=”blog”>
</textarea>
<br>
<input type=”submit”>
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Langkah 3:

Membuat Aplikasi Kedua,
InsertBlog.asp

Kalau seorang blogger sudah memasukkan
data-datanya pada form di atas, ke-
manakah data-data itu akan pergi? Tentu,
data-data itu akan masuk dan tersimpan
rapat ke dalam database. Hanya saja, siapa
yang bertugas untuk menyimpan data-
data itu ke dalam database? Kali ini kita
akan membuat script yang bertanggung ja-
wab untuk mengemban tugas itu. Kita
memberinya nama Insertblog.asp.

Pertama kali, kita mengikutsertakan
file adovbs.inc lewat satu baris pernyataan
di bawah ini:

<!—#include file=”adovbs.inc”—>

File ini sendiri berisi konstanta-kon-
stanta yang dibutuhkan script untuk me-
nangani manipulasi database. Langkah be-
rikutnya adalah membuat variabel-variabel
yang diperlukan dalam script meskipun
langkah ini sebenarnya tidak mutlak harus
dilakukan. ASP mengizinkan Anda mem-
buat script tanpa mendeklarasikan variabel
terlebih dulu.

<% Dim oConn, objRs, letakfile %>

Kita akan segera melakukan koneksi
menuju database lewat metode DSN-less
Connection. Yang paling penting kita la-
kukan adalah menentukan letak file data-

base ‘blog.mdb’ secara tepat. Sebab jika
meleset, script pasti akan error. Potongan
baris berikut ini berfungsi untuk menen-
tukan lokasi file ‘blog.mdb’ secara tepat,
yaitu menggunakan Server.Mappath:

<% letakfile =
server.mappath(“blog.mdb”) %>

Setelah itu, kita ciptakan koneksi lewat
metode DSN-less Connection seperti ini:

<% Set oConn =
Server.CreateObject(“ADODB.Connection”)
%>
<% oConn.Open “DRIVER={Microsoft
Access Driver (*.mdb)}; DBQ=” & letakfile
%>

Kini, koneksi menuju database telah
terjalin. Sekarang, kita butuh akses menuju
record yang ada di dalam database itu entah
untuk keperluan menambah record baru,
menghapus, atau memodifikasinya. Kali ini,
kita butuh akses seperti itu untuk menambah
record baru. Caranya yaitu dengan menggu-
nakan recordset object seperti ini:

<% Set objRs =
Server.CreateObject(“ADODB.Recordset”)
%>
<% objRs.Open “webblog”, oConn,
 adOpenKeySet, adLockOptimistic %>

Pada pernyataan kedua, kita akan
membuka tabel database bernama
‘Webblog’ yang dulu kita buat. Selanjut-
nya, kita pilih recordset parameter untuk
Cursor Type berjenis ‘adOpenKeySet’ dan
Lock Type berjenis ‘adLockOptimistic’. Pa-
sangan cursor type dan lock type ini sangat
ideal untuk penambahan record baru.

Sebelum kita memasukkan record
baru ke dalam database, kita akan berma-
in-main dengan bilangan acak. Tentu
Anda ingat bahwa dalam tabel database
‘Webblog’ terdapat field ‘BlogID’. Field ini

Lihatlah masing-masing komponen
form di atas. Tampak hanya text-box
‘Tanggal’ dan ‘Pukul’ yang sudah terisi oleh
data di dalamnya. Data yang masuk adalah
data tanggal sekarang ‘<%=Date%>’ dan
data waktu sekarang ‘<%=Time%>’. Selain
itu, masing-masing text-box dan text area
belumlah terisi oleh data apa pun. Ingat
bahwa Anda harus memberi nama pada
masing-masing text-box secara spesifik.
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Langkah 4:

Uji Coba Script CreateBlog.asp
dan InsertBlog.asp

Sekarang, mari kita uji kedua script di atas
langsung menggunakan browser. Langkah
pertama yaitu luncurkan browser (IE,
Netscape, NeoPlanet). Kemudian, ketik
URL berikut ini: http://localhost/webblog/
createblog.asp.

bertugas untuk merekam nomor ID setiap
web blog yang masuk. Dan, seperti layak-
nya nomor ID yang lain, nomor ID web
blog ini unik satu dengan lainnya. Lantas,
bagaimana cara membuatnya? Di sini, saya
akan menciptakan angka acak yang diha-
silkan lewat pernyataan berikut ini:

<% randomize %>
<% acak = round(rnd * 1234567890) %>
<% acak = “Blog” & acak %>

Pertama kali, angka acak akan tersim-
pan di dalam variabel ‘acak’. Semakin ba-
nyak rentetan angka yang kita tuliskan di
atas, semakin besar pula kombinasi nomor
ID yang akan dihasilkan. Setelah angka
acak berhasil diciptakan, di depan angka
itu akan disisipi kata ‘Blog’ seperti tampak
pada baris ketiga di atas. Dengan begitu, sa-
lah satu record yang ada di field ‘BlogID’
mungkin seperti ini: “Blog4231953106”.
Baru setelah itu, kita ciptakan record baru
ke dalam database menggunakan metode
AddNew dari Recordset seperti ini:

<% objRs.AddNew %>

Lantas, record-record itu akan masuk
dalam rupa apa? Lihat potongan-potongan
baris berikut ini:

<% objRs(“BlogID”) = acak %>
<% objRs(“tanggal”) =
request.form(“tanggal”) %>
<% objRs(“waktu”) =
request.form(“pukul”) %>
<% objRs(“judul”) = request.form(“judul”)
%>
<% objRs(“nama”) =
request.form(“nama”) %>
<% objRs(“blog”) = request.form(“blog”) %>

Itu artinya, field ‘BlogID’ akan terisi
oleh nilai yang ada di dalam variabel ‘acak’.
Sedang field ‘tanggal’, ‘waktu’, ‘judul’,
‘nama’, dan ‘blog’ akan terisi oleh data-data

yang telah dimasukkan oleh pengunjung
ke dalam masing-masing komponen form
(text-box, text area dan lain-lain).

Setelah itu, kita pakai metode Update
seperti ini agar record-record tadi benar-
benar tersimpan di dalam database.

<% objRs.Update %>

Lantas, apakah record-record itu berha-
sil masuk ke dalam database? Untuk mem-
buktikannya, kita akan memunculkan isi
database ke dalam jendela browser.

Pertama kali, kita munculkan isi dari
field ‘Judul’ ke layar browser lewat pernyata-
an berikut ini:

<b>”<%=objRs(“judul”)%>”</b>

Jika sudah, kita munculkan pula field-
field yang lain seperti ‘Tanggal’, ‘Waktu’,
‘Nama’ dan sebagainya:

Tanggal: <%=objRs(“tanggal”)%>
Pukul: <%=objRs(“waktu”)%>
Dibuat oleh: <%=objRs(“nama”)%>

Terakhir, kita munculkan isi blog ke jen-
dela browser lewat cara yang sama seperti ini:

<%=objRs(“blog”)%>

Setelah selesai memakai database, kita
tutup akses menuju record-record itu lewat
pernyataan ini:

<% objRs.Close %>
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Membuat Web Blog Baru:     Form di samping ini
berfungsi untuk membuat web blog baru yang
dapat dimanfaatkan oleh siapa saja.

Menengok Blog Baru:     Blog yang telah berhasil
dibuat akan dimunculkan ulang ke jendela
browser agar Anda sebagai si pengarangnya bisa
melihat kembali apa yang baru saja Anda tulis.

Beberapa Catatan Kecil

1. Buatlah minimal lima blog sekaligus
dengan mengulangi proses pembu-
atan blog lewat browser seperti tadi
telah kita lakukan. Jika Anda mem-
buat kurang dari lima blog maka
script ‘blog.asp’ yang akan kita buat
setelah ini akan menghasilkan error.

2. Kedua script yang tadi telah kita
buat, yaitu createblog.asp dan
insertblog.asp, dapat Anda temukan
di dalam CD dalam versi lengkap.

Setelah itu, tekan tombol Submit.
Server akan memproses script insert-
blog.asp dan akan merekam semua data
yang Anda tuliskan dalam komponen
form ke dalam database. Dan kini, data-
data yang telah tersimpan itu muncul
kembali ke hadapan Anda lewat jendela
browser seperti gambar di bawah ini:

Anda akan melihat tampilan web ber-
form tempat Anda membuat blog baru.
Isikan data-data Anda ke dalam form yang
telah tersedia seperti gambar di bawah ini.

Langkah 5:

Membuat Script
Blog.asp

Apa yang tadi telah kita buat? Tadi, kita
membuat dua buah script, yaitu create-
blog.asp dan insertblog.asp yang berfungsi
untuk merekam atau menyimpan blog
baru yang ditulis seorang blogger ke dalam
database. Tentu, perjalanan kita tidak ha-
nya berhenti sampai di sini saja. Kita harus
memuaskan rasa ingin tahu blogger-
blogger yang lain tentang isi pikiran rekan-
rekan mereka. Caranya? Kita munculkan
record para blogger itu ke halaman web.

Dengan kata lain, kita ingin membuat
halaman utama web blog ini. Di sini, blog-
blog terbaru akan dimunculkan dalam ha-
laman utama agar semua orang, entah par-
tisan atau pembaca setia, dapat menikmati
blog-blog itu. Untuk mewujudkan hal ini,
kita butuh sebuah script yang akan kita
beri nama Blog.asp.

Marilah kita telusuri langkah demi
langkah pembuatan script Blog.asp ini.
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Pertama kali, kita tentukan dulu judul
dari website ini. Judul ini akan muncul di
jendela browser. Teks yang diapit tag
<Title>…</Title> dari HTML akan men-
jadi judul website ini. Ubahlah sesuai selera
Anda jika perlu.

<html>
<head>
<title>
::Welcome to My Web Blog! ::
</title>
</head>

Langkah kedua adalah menciptakan
koneksi menuju database. Cara ini pernah
kita pakai saat membuat insertblog.asp.
Tekniknya sama persis, yaitu dengan
menggunakan DSN-Less Connection:

<% Dim oConn, objRs, letakfile %>
<% letakfile =
server.mappath(“blog.mdb”) %>
<% Set oConn=
Server.CreateObject(“ADODB.Connection”)
%>
<% oConn.Open “DRIVER={Microsoft
Access Driver (*.mdb)}; DBQ=” & letakfile
%>

Kalau koneksi sudah terjalin, kita buka
akses menuju record-record yang ada di da-
lam database menggunakan Recordset Ob-
ject seperti ini.

<% Set objRs =
 Server.CreateObject(“ADODB.Recordset”)
%>
<% objRs.Open “SELECT * FROM Webblog
ORDER BY Tanggal DESC”, oConn %>

Lihat perintah SQL di atas yang berbu-
nyi “SELECT * FROM Webblog ORDER
BY Tanggal, Waktu DESC”. Itu artinya,
kita akan mengambil semua field dari tabel

‘Webblog’. Nanti, record-record yang ada
di semua field itu akan ditampilkan ke jen-
dela browser. Bagaimana dengan urutan-
nya? Record-record itu akan diurutkan
berdasarkan field ‘Tanggal’. Lantas? Meto-
de pengurutan yang kita ambil adalah
DESC yang artinya record terbaru yang
memiliki tanggal atau waktu paling baru
akan muncul di atas disusul record-record
yang memiliki tanggal atau waktu lebih
lama. Dengan begitu, blog-blog yang mun-
cul di halaman ini akan selalu baru.

Sekarang, kita akan atur berapa blog
yang akan muncul di halaman utama.
Ingat bahwa dengan semakin banyak blog
yang masuk ke halaman utama, akses web
menuju situs ini akan lebih melambat. Ca-
ranya yaitu dengan mengatur PageSize se-
perti contoh di bawah ini:

<% objRs.PageSize = 5 %>

Kalau kita isi dengan angka 5 maka
blog yang akan muncul di halaman utama
ini berjumlah lima buah. Kalau kita ubah
menjadi angka 2 maka hanya ada dua blog
saja seperti gambar di samping.

Ingat bahwa Anda paling tidak harus
memiliki jumlah blog lebih besar dari ang-
ka yang Anda set di PageSize. Itu artinya,
kalau Anda set PageSize sama dengan 5
maka minimal Anda harus punya lima
record blog terlebih dulu di dalam data-
base. Jika tidak maka script di atas akan er-
ror.

Setelah pengaturan di atas selesai, kita
akan tulis judul untuk halaman web di
atas. Judul ini diatur oleh baris-baris script
di bawah ini:

<font face=”arial” size=6 color=”red”>
<p align=”center”>
<b>MY WEB BLOG</b>
</p>
</font>
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Mengatur PageSize:Mengatur PageSize:Mengatur PageSize:Mengatur PageSize:Mengatur PageSize:     Jika Anda mengatur
PageSize sama dengan 2 maka hanya ada dua
blog dalam halaman utama seperti gambar di
atas. Berapa jumlah blog yang akan muncul
bergantung pada angka yang Anda masukkan di
sini.

Jika Anda ingin menggantinya dari
‘MY WEB BLOG’ menjadi teks Anda sen-
diri, ubahlah bagian itu sesuai keinginan
Anda.

Kini, kita akan membuat tabel 1 ko-
lom dan 1 baris. Tujuannya, agar teks blog
yang muncul nanti tidak terlalu meman-
jang ke kanan dan ke kiri. Artinya, kita
membatasi rentang teks blog agar tampak
lebih rapi dan artistik. Untuk membuat ta-
bel, kita butuh tag HTML berikut ini:

<table border=”0" width=”60%”>
<tr>
<td>

Anda bisa atur sendiri berapa besar ta-
bel yang akan memagari teks blog dengan
cara mengubah angka yang ada di atribut
Width di atas. Anda bisa mengisinya baik
dalam satuan persen maupun pixel.

Sekarang, kita akan munculkan blog-
blog yang ada di dalam database ke jendela
browser. Berapa blog yang akan kita
munculkan? Dan bagaimana cara kita
memunculkannya? Ada beragam teknik
memunculkan record-record yang ada di
dalam database ke jendela browser, salah
satunya adalah dengan menggunakan
pengulangan For… Next berikut ini:

<% for i = 1 to objRs.PageSize %>

Pengulangan di atas memiliki makna
lebih luas, yaitu ia akan memanggil record
sejumlah angka yang tersimpan di dalam
variabel ‘i’. Dalam contoh di atas karena
PageSize bernilai 5 maka pengulangan ter-
sebut hanya berjalan lima kali. Dengan
kata lain, record blog yang akan muncul
berjumlah lima buah. Selanjutnya, kita
akan munculkan judul blog terlebih dulu
sebelum data-data lain muncul di jendela
browser seperti tanggal, waktu, nama si
pembuat, dan isi blog itu sendiri.

Cara untuk memunculkan judul blog
adalah dengan menggunakan potongan
script berikut ini:

<font face=”arial” size=4 color=”blue”>
<b><%=objRs(“judul”)%></b>
</font>

Karena berupa judul maka huruf-huruf
yang memoles judul itu haruslah berukur-
an khas atau lebih besar dari yang lain. Da-
lam contoh di atas, besarnya huruf yang
saya pilih adalah 4 point dengan warna
blue.

Langkah berikutnya, kita bubuhkan
data-data terkait dengan blog itu seperti
tanggal pembuatan, pukul pembuatan,
dan siapa yang membuatnya. Data-data ini
berfungsi sebagai pelengkap dan terkadang
teramat penting bagi orang lain karena
mereka bisa tahu siapa orang di balik
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Memunculkan Judul: Langkah pertama, kita
munculkan judul Blog terlebih dulu ke jendela
browser seperti pada contoh di atas.

curahan hati tersebut. Tapi, supaya tampil-
annya tidak timpang, huruf yang memoles
teks ini dibuat lebih kecil dari yang lain.

Cara untuk menampilkan data-data
tersebut adalah sebagai berikut:

<font face=”arial” size=1 color=”black”>
Dibuat oleh: <%=objRs(“nama”)%>
Tanggal: <%=objRs(“tanggal”)%>
Pukul: <%=objRs(“waktu”)%>
</font>

Terakhir, baru kita munculkan isi blog
ke dalam halaman web. Sampai langkah
ini, semua isi blog beserta data lainnya su-
dah muncul seluruhnya.

<br>
<br>

<font face="arial" size=2 color="black">
<%=objRs("blog")%>
</font>

Data-data Lainnya: Meskipun kecil, namun data-
data pendukung seperti tanggal dan waktu
pembuatan serta siapa yang mencurahkan isi
hatinya itu memiliki peranan yang penting.

Setelah itu, kita tulis dua baris script di
bawah ini. Tujuannya, agar ketika script se-
lesai dengan record pertama, ia akan
membaca record kedua, ketiga, dan sete-
rusnya sampai pengulangan For…Next ini
berhenti.

<% objRs.MoveNext %>
<% Next %>

Seperti skema di atas, hanya ada kira-
kira lima blog yang akan muncul di hala-
man utama ini. Lantas, bagaimana nasib
blog terakhir jika muncul blog ke enam?
Otomatis, blog yang paling lama akan
tergeser dengan yang baru. Namun jangan
khawatir sebab nasib blog yang terakhir ini
belumlah tamat. Seperti layaknya web blog
lainnya, blog-blog yang lama akan masuk
ke dalam arsip. Dan, arsip-arsip blog ini
akan diatur oleh script khusus. Para
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Tahap Akhir:     Kini, halaman web blog ini tampil
seutuhnya.Anda boleh memodifikasi script
Blog.asp untuk menghasilkan output yang
beragam dan beraneka rupa.

Langkah 6:

Membuat Script
BlogArchieves.asp

Seperti telah disinggung di atas, koleksi

blog yang telah ‘usang’ janganlah kita bu-

ang begitu saja. Terkadang, banyak blogger

suka membaca blog-blog yang justru sudah

lama di-posting. Lantas, di mana kita me-

letakkan koleksi blog yang lama itu? Da-

lam halaman web utama, Anda melihat

link bertuliskan ‘Arsip Blog’. Jika link itu

diklik, pengunjung akan dibawa ke script

BlogArchieves.asp. Nah, script ini bertugas

untuk mengoleksi serta mendata semua

arsip blog yang ada di dalam database un-

tuk selanjutnya dimunculkan ke jendela

browser.

Berbeda dengan halaman utama, hala-

man yang nanti akan dihasilkan oleh script

BlogArchieves.asp ini terkesan lebih ring-

kas. Hal ini terjadi karena kita tidak me-

munculkan semua isi blog. Yang kita

munculkan hanyalah judul serta data-data

pendukung seperti tanggal dan waktu

pembuatan serta nama orang yang

mengarangnya.

Lantas, bagaimana caranya para blog-

ger membaca blog-blog itu? Caranya, di se-

tiap judul blog itu kita sisipi link yang akan

mengarah ke script lain, dalam hal ini ber-

nama blogdetail.asp yang akan kita buat

belakangan. Script ini bertugas untuk

mendeteksi BlogID yang dikirim oleh

blogArchieves.asp untuk selanjutnya isi

blog itu dimunculkan ke jendela browser.

blogger bisa masuk ke halaman khusus ar-

sip ini jika ia mengklik link ‘Arsip Blog’.

Lantas, ke mana blogger-blogger itu akan

pergi?

Lihat link berikut ini:

<a href=”blogarchieves.asp”>

<b>Arsip Blog</b>

</a>

Jika link ini diklik, pengunjung akan

masuk ke script blogarchieves.asp seperti

tampak pada belahan script di atas.
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Bagaimana membuat BlogArchieves.

asp itu? Pada prinsipnya, 40% isi script

BlogArchieves.asp menyerupai script

Blog.asp. Pada tahap pertama, Anda buat

terlebih dulu judul halaman web ini meng-

gunakan baris-baris HTML berikut:

<html>

<head>

<title>

::Welcome to My Web Blog! ::

</title>

</head>

Setelah itu, kita ciptakan koneksi me-

nuju database menggunakan DSN-Less

Connection. Kalau sudah terjalin koneksi

itu, kita buka akses menuju record-record

yang ada di dalam database menggunakan

Recordset Object.

<% Set oConn =

Server.CreateObject(“ADODB.Connection”) %>

<% oConn.Open “DRIVER={Microsoft Access Driver

(*.mdb)}; DBQ=” & letakfile %>

<% Set objRs =

 Server.CreateObject(“ADODB.Recordset”) %>

<% objRs.Open “SELECT * FROM Webblog ORDER

BY Tanggal DESC”, oConn %>

Di sini, kita masih menggunakan pe-

rintah SQL yang sama dengan perintah

SQL yang kita pakai pada script Blog.asp.

Selanjutnya, kita set judul halaman

web yang nanti akan muncul di jendela

browser sama seperti script Blog.asp di atas.

Caranya seperti ini:

<font face=”arial” size=6 color=”red”>

<p align=”center”>

<b>MY WEB BLOG ARCHIEVES</b>

</p>

</font>

Setelah kita membuat tabel agar pena-

taan lay out halaman ini lebih rapi, kita

akan memulai proses mengambil record-

record yang ada di dalam database ke jen-

dela browser. Teknik yang akan kita pakai

ini berbeda dengan teknik yang kita pilih

untuk script Blog.asp. Setelah kita membu-

at tabel agar penataan lay out halaman ini

lebih rapi, kita akan memulai proses meng-

ambil record-record yang ada di dalam da-

tabase ke jendela browser. Teknik yang

akan kita pakai ini berbeda dengan teknik

yang kita pilih untuk script Blog.asp.

Di sini, kita menggunakan pengulang-

an Do…Loop untuk membaca semua

record yang ada di dalam database untuk

kemudian dimunculkan ke jendela browser.

Pengulangan itu kita tuliskan seperti ini:

<% Do While NOT objRs.EOF %>

Itu artinya, pengulangan akan terus di-

lakukan sampai record terakhir dan kursor

menyentuh akhir file (End Of File). Atau

dengan kata lain, lewat pengulangan di

atas, kita ingin menampilkan semua

record yang ada di dalam database ke jen-

dela browser.

Setelah itu, kita munculkan judul blog

ke jendela browser. Tekniknya cukup se-

derhana. Hanya saja, seperti tadi telah kita

singgung, di dalam judul blog ini tertanam

sebuah link. Link ini jika diklik akan mem-

bawa si blogger itu ke script lain, yaitu

BlogDetail.asp. Caranya seperti berikut ini:

<a href=

”blogdetail.asp?blogID=
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<%=objRs(“BlogID”)%>”>

<%=objRs(“judul”)%>

</a>

Apakah cukup berhenti di sini? Tidak.

Lihat teknik penulisan URL di atas pada

atribut href. Jika link di atas diklik maka

akan terjadi dua akibat yang akan muncul.

Pertama, pengunjung akan dibawa ke

script blogdetail.asp. Kedua, script blogar-

chieves.asp ini akan mengirim sebuah nilai

yang tersimpan di dalam variabel ‘BlogID’

seperti tampak pada penulisan alamat link

di atas ke script blogdetail.asp. Apa isi nilai

yang tersimpan di dalam variabel ‘BlogID’

ini? Isinya adalah record yang ada di field

‘BlogID’ dalam database. Lantas, apa fung-

si nilai itu? Kita akan membahasnya saat

membuat script blogdetail.asp.

Setelah kita memunculkan judul blog,

kita tayangkan data-data pendukung se-

perti tanggal, waktu dan sebagainya. Tek-

niknya sama dengan teknik yang telah kita

pelajari waktu lalu:

Dibuat oleh: <%=objRs(“nama”)%>

Tanggal: <%=objRs(“tanggal”)%>

Pukul: <%=objRs(“waktu”)%>

Kini, kita memasuki langkah-langkah

terakhir. Pertama, setelah selesai dengan

satu record, kita gerakkan kursor ke record

selanjutnya menggunakan MoveNext se-

perti ini.

<% objRs.MoveNext %>

Kedua, kita perintahkan server agar

melakukan pengulangan kembali sampai

kursor menyentuh End Of File (EOF:

akhir dari file).

Arsip Blog: Lewat script khusus, kita munculkan
arsip-arsip blog yang dulu pernah ditulis oleh
blogger dalam periode sekarang sampai waktu
paling lama.

Langkah 7:

Membuat Script
BlogDetail.asp

Tiba waktunya untuk membuat script tera-

khir, yaitu BlogDetail.asp. Script ini akan

muncul saat seorang blogger masuk ke ha-

laman arsip dan mengklik salah satu judul

yang ada di sana. Begitu mereka melaku-

kan hal tersebut, ia akan membaca isi blog

secara lengkap. Bagaimana hal ini bisa ter-

jadi? Kita akan telusuri satu demi satu ba-

ris-baris script yang ada di dalam tubuh

BlogDetail.asp ini.

Pada prinsipnya, baris-baris pertama

yang ada di dalam BlogDetail.asp ini sama

dengan yang lain. Coba tengok potongan

berikut ini:

<html>

<head>
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<title>

::Welcome to My Web Blog! ::

</title>

</head>

<body>

<% Dim oConn, objRs, letakfile %>

<% letakfile =

server.mappath(“blog.mdb”) %>

<% Set oConn=

Server.CreateObject(“ADODB.Connection”)

%>

<% oConn.Open “DRIVER={Microsoft

Access Driver (*.mdb)}; DBQ=” & letakfile

%>

Perbedaan baru muncul tatkala kita

bekerja dengan perintah SQL. Lihat 2 baris

script berikut ini:

<% Set objRs =

 Server.CreateObject(“ADODB.Recordset”)

%>

<% objRs.Open “SELECT * FROM Webblog

WHERE BlogID=

’” & Request.QueryString(“BlogID”) & “‘“,

oConn %>

Di situ tampak satu baris perintah SQL

yang fungsinya untuk mengambil record

dari database. Lantas pertanyaannya,

record mana yang akan diambil? Tentu,

halaman web ini hanya akan memuncul-

kan blog yang masih memiliki ikatan de-

ngan judul yang telah dipilih oleh seorang

blogger. Bagaimana mendeteksinya? Kita

bisa menggunakan pernyataan WHERE

untuk menyeleksi record. Lihat potongan

perintah SQL di bawah ini:

WHERE BlogID=’” &

Request.QueryString(“BlogID”)&”’”

Perintah SQL hanya akan mengambil

record yang memiliki nilai pada field

‘BlogID’ sama dengan nilai yang dikirim

oleh script blogarchieves.asp lewat URL. Li-

hat link yang ada di dalam script

blogarchieves.asp berikut ini:

<a href=

”blogdetail.asp?blogID=

<%=objRs(“BlogID”)%>”>

Ingat, begitu link diklik, variabel

‘blogID’ di atas akan menyimpan nilai se-

perti yang ada di record ‘BlogID’. Dan, de-

ngan menggunakan QueryString, kita am-

bil nilai itu untuk menyeleksi record.

Setelah record terseleksi, semuanya

menjadi lebih mudah. Kita tinggal melaku-

kan persiapan-persiapan awal untuk me-

moles tampilan halaman web ini. Pertama

kali, kita atur ulang judul halaman web ini

lewat tag-tag HTML berikut:

<font face=”arial” size=6

color=”red”>

<p align=”center”>

<b>MY WEB BLOG DETAIL</b>

</p>

</font>

Selanjutnya, kita munculkan judul

blog terlebih dulu ke jendela browser lewat

potongan baris di bawah ini:

<font face=”arial” size=4 color=”blue”>

<b><%=objRs(“judul”)%></b>

</font>

Kemudian, baru disusul record-record

lainnya termasuk record yang bertindak
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Catatan Kecil

Ketiga script, yaitu blog.asp, blogar-
chieves.asp, dan blogdetail.asp ada da-
lam CD pendamping buku.

Blog Detail: Begitu judul salah satu arsip blog
diklik, seorang blogger bisa melihat isi blog
secara lengkap lewat script yang sengaja kita
rancang untuk itu, yaitu blogdetail.asp.

Mempercantik Blog

Memoles Blog dengan
Dreamweaver MX 2004

Kini, kita sudah punya script web blog siap

pakai yang dapat Anda modifikasi sesuai

selera sendiri. Kalau boleh jujur, tampilan

wajah web blog yang baru saja kita buat ma-

sih sangat “mentah” dalam hal desain. Un-

tuk itu, kita akan mempercantiknya de-

ngan cara yang paling efektif dan efisien,

yaitu menggunakan Macromedia Dream-

weaver MX 2004—satu-satunya software

desain web paling lengkap dan canggih.

Kali ini, kita tidak bicara tentang

scripting ASP menggunakan Dreamweaver

MX 2004 meskipun hal itu bisa saja dilaku-

kan. Sebaliknya, kita bicara tentang

Dreamweaver MX 2004 dalam kaitannya

dengan desain web blog ini. Saya berharap

Anda sudah punya software ciptaan

Macromedia ini sehingga proses latihan

kali ini bisa berjalan tanpa masalah.

Langkah pertama, luncurkanlah Ma-

cromedia Dreamweaver MX 2004 yang ada

dalam sistem komputer Anda sampai

Anda melihat tampilan gambar seperti

pada gambar halaman 17 (kiri atas).

sebagai blog itu sendiri. Semuanya kita

munculkan di jendela browser lewat bebe-

rapa pernyataan di bawah ini:

<font face=”arial” size=1 color=”black”>

Dibuat oleh: <%=objRs(“nama”)%>

Tanggal: <%=objRs(“tanggal”)%>

Pukul: <%=objRs(“waktu”)%>

</font>

<br><br>

<font face=”arial” size=3 color=”black”>

<%=objRs(“blog”)%>

</font>

Sekarang kalau perlu, kita cantumkan

link untuk kembali ke halaman arsip atau

halaman awal lewat pernyataan ini:

<a href=”blogarchieves.asp”>Kembali ke

Arsip</a>

<br>

<a href=”blog.asp”>Kembali ke Halaman

Utama</a>
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Tampilan Utama Dreamweaver MX 2004:
Begitu Anda me-launch software yang masih
saudara kandung Flash MX 2004 ini, Anda akan
menjumpai tampilan seperti gambar di atas.

ASP dalam Jendela Dreamweaver MX 2004:
Tampak pada gambar di samping, script
Blog.asp kita munculkan dalam jendela
Dreamweaver MX 2004 seperti gambar di
samping.

Di jendela itu muncul icon kuning
bertuliskan ‘ASP’. Janganlah Anda sentuh
atau malah dihapus sebab icon-icon itu
mewakili kode-kode ASP yang tak dapat
diterjemahkan secara visual oleh
Dreamweaver MX. Kali ini, kita akan bela-
jar untuk mengganti warna latar belakang
web blog di atas dari putih menjadi warna
lain.

Caranya, klik menu Modify dan pilih-
lah Page Properties sampai Anda masuk ke
jendela seperti gambar di bawah ini.

Pastikan dalam bagian Category Anda
memilih Appearance. Selanjutnya, klik ko-
tak kecil yang ada di samping kanan Back-
ground. Pilihlah salah satu warna favorit
Anda segera setelah Anda melihat jendela
warna. Jika sudah, tekan OK. Sekarang, ha-
laman web blog.asp sudah memiliki warna
latar belakang seperti gambar di bawah ini:

Klik pilihan Open dan bukalah script

Blog.asp sehingga script tersebut muncul

dalam jendela Dreamweaver MX 2004 se-

perti gambar di bawah ini.

Page Properties:
Untuk mengatur
warna latar belakang
halaman web, pilihlah
Page Properties (kiri).
Sedangkan gambar di
bawah adalah gambar
jendela Page
Properties untuk
pengaturan banyak
hal yang berkaitan
dengan halaman web.
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Blog.asp dengan Wajah Baru: Anda bisa
mendesain sendiri warna latar belakang favorit
Anda.

Sekarang, kita akan mengganti judul

web blog tersebut yang semula teks ‘MY

WEB BLOG’ menjadi grafis. Sebelumnya

Anda harus mendesain terlebih dulu gam-

bar yang akan menjadi judul web blog itu.

Sebagai pedoman buat Anda, di dalam CD

tersedia file title.gif yang dapat Anda jadi-

kan contoh latihan. Bukalah file tersebut

dan Anda akan melihat contoh gambar se-

perti tampilan berikut ini:

Judul Berbentuk Grafis: Untuk mempercantik
tampilan halaman web, terkadang kita harus
melibatkan file grafis meskipun di dalamnya ia
berbentuk teks seperti gambar di atas.

Kemudian, tekan menu Insert dan pi-

lih Image. Selanjutnya, carilah file gambar

yang ingin Anda abadikan sebagai judul

web blog ini. Dalam contoh kali ini, Anda

bisa memanfaatkan file title.gif yang ada di

dalam CD.

Insert Image: Untuk memasukkan gambar ke
dalam halaman web, salah satu cara yang
sering dipakai yaitu dengan menggunakan
menu Insert > Image Insert > Image Insert > Image Insert > Image Insert > Image seperti diperlihatkan pada
gambar di atas ini.

Wajah Baru Blog.asp: Setelah diberi judul dalam
wujud gambar, halaman web blog.asp di atas
tampak lebih bagus meskipun kita baru bisa
menikmati secara utuh lewat jendela browser.

Yang pertama kali harus kita lakukan

adalah menghapus teks ‘MY WEB BLOG’

terlebih dulu agar nanti bisa diganti de-

ngan file gambar di atas. Hapuslah dengan

cara memblok atau menghilangkan satu

demi satu huruf yang ada di situ.


